M4  

BASICS OF RAMAN SPECTROSCOPY

Figure 1: Modulation of the scattered radiation of a vibrating molecule.\cite{1}

I. INTRODUCTION

When electromagnetic radiation of energy $hv_0$ irradiates a molecule, it may be transmitted, absorbed or scattered.

For scattered light, the Tyndall effect describes scattering by microscopic particles (e.g. smoke or fog). In Rayleigh scattering, the molecules themselves scatter the light (one result is the blue sky). No change in wavelength occurs in either Tyndall or Rayleigh scattering.

Careful inspection, however, reveals that in addition to the Rayleigh scatter at $v_0$, a tiny proportion is shifted to a lower frequency $v_0 - v_S$ and an even smaller fraction to a higher frequency $v_0 + v_S$. This shifted radiation was experimentally observed in liquids and first published in March 1928 by Raman & Krishnan.\cite{2} Almost simultaneously, soviet physicists Landsberg & Mandelstam observed the same effect in crystals.\cite{3} The phenomenon was named after the Indian physicist Chandrasekhar Venkata Raman, who was awarded The Nobel Prize in Physics in 1930 "for his work on the scattering of light and for the discovery of the effect named after him".\cite{4} An independent prediction of this phenomenon had been made a few years earlier by Smekal using classical quantum theory.\cite{5}

In this lab course, the basic features of Raman scattering will be investigated using different spectrometers and techniques.

---

1 originated by Dr. H. Weigt, revised by Dr. F. Jaiser
EXPERIMENTAL TASKS

- measurement of a weakly fluorescent sample with a luminescence spectrometer
- assignment of all observed features, justification of these assignments
- calibration of a Raman spectrometer, using a reference material
- measurement of Raman spectra for different (known) samples
- assignment of the observed features to molecular properties
- material identification with the help of Raman spectra
- relation of features observed in the luminescence spectra to features observed in Raman spectra of the same compounds

CONTENTS

I. INTRODUCTION ......................................................................................................................... 1

II. FUNDAMENTALS ......................................................................................................................... 3

   II.1 CLASSICAL MODEL OF RAMAN SCATTERING [6] ................................................................. 3
   II.2 A QUANTUM MECHANICAL PICTURE .................................................................................. 4
   II.3 THE APPEARANCE OF A RAMAN SPECTRUM, QUANTITIES & UNITS .................................. 6
   II.4 STOKES VS. ANTI-STOKES – THERMAL EFFECTS .................................................................. 7
   II.5 RAMAN SPECTROSCOPY VERSUS INFRARED SPECTROSCOPY ............................................ 8
   II.6 POLARIZATION PROPERTIES OF RAMAN SCATTERING ..................................................... 9
   II.7 THE CONCEPT OF GROUP FREQUENCIES ........................................................................... 11
   II.8 RAMAN SPECTROSCOPY OF POLYMERS & MICROSAMPLING ........................................ 12
   II.9 BASIC EXPERIMENTAL ASPECTS ....................................................................................... 14
   II.10 THE ACTUAL EXPERIMENTAL SETUP ............................................................................... 14

III. EXPERIMENT EXECUTION AND ANALYSIS ............................................................................ 16

   III.1 GENERAL REMARKS ......................................................................................................... 16
   III.2 LIGHT SCATTERING & FLUORESCENCE – AN INTRODUCTORY EXPERIMENT ...................... 16
   III.3 THE RAMAN SPECTROMETER – WAVE NUMBER CALIBRATION ........................................ 16
   III.4 MEASUREMENT OF RAMAN SPECTRA ................................................................................ 17

IV. INSTRUMENTATION .................................................................................................................... 18

   IV.1 PERKIN-ELMER LS 55 LUMINESCENCE SPECTROMETER .................................................. 18
   IV.2 RAMAN SPECTROMETER “ADVANTAGE 200A” AND “NUSPEC BASIC” SOFTWARE .................. 19

V. REFERENCES ............................................................................................................................... 22
II. FUNDAMENTALS

In the following we will not go into great detail about the classical and quantum theories of Raman spectroscopy. There are numerous books and articles available which detail the theory and the many applications providing a detailed coverage of this topic. Some of these are listed in the references.

For the purposes of this lab, the background of this manual is limited to the experimental tasks, helpful recommendations and some basics.

It is recommended to first study some of the articles which are cited as “suggested reading” at the end of this manual, which include selected reviews suitable to the context of this lab course. The articles will look in some detail at the vibrations of molecules as these are crucial to the interpretation of the measured spectra and the underlying Raman effect.

Molecular quantum mechanics is the theory which attempts to explain, or even to predict, the experimental observations of spectroscopy. However, in the context of this lab experiment advanced mathematics is avoided as far as possible, we will use only the results of quantum mechanics. For our purposes you should visualize a molecule as a physical entity rather than a series of mathematical equations.

Once you have worked through the experiments you will have some idea not only about the information to be gained from Raman spectroscopy but also about the sampling technique and procedure.

II.1 CLASSICAL MODEL OF RAMAN SCATTERING

In many respects, the treatment of the scattering of light by a molecule is simplified by using the wave description of light. When a light wave meets a molecule composed of electrons and nuclei, the electric field exerts the same force on all electrons and tends to displace them from their average positions around the positively charged nuclei. It is crucial for the Raman process that these displacements result in an induced dipole moment \( \mu \) in the molecule which is, to a first-order approximation\(^2\), proportional to the electric field strength \( E \) of the light wave,

\[
\mu = \alpha E.
\]  

(1)

The proportionality factor \( \alpha \) is called the electric polarizability of the molecule. It is a measure of how easily a molecule can be distorted to create a dipole moment.

For example, large atoms such as xenon have a strong polarizability because their electron clouds – distant from the nucleus – are relatively easy to distort with an applied electric field. Polarizabilities for atoms are isotropic (i.e., the same in all directions), whereas polarizabilities for molecules may vary with position about the molecule, depending on the molecule's symmetry. Thus you may see \( \alpha \) labeled with Cartesian coordinates to indicate the particular direction to which it refers.

Now it turns out that the key property of a molecule scattering a photon is exactly the molecule's polarizability. Certain movements of a molecule occur with concurrent changes in the polarizability of the molecule. Therefore, in some cases, the polarization of the molecule changes.

Mathematically, this is fairly straightforward to show. For a diatomic molecule in its equilibrium geometry, the polarizability has some value \( \alpha_0 \). At some displacement, \( \Delta r \), away from equilibrium, the instantaneous polarizability \( \alpha \) is given by

\[
\alpha = \alpha_0 + \left( \frac{\partial \alpha}{\partial r} \right) \Delta r
\]

(2)

where the derivative \( \left( \frac{\partial \alpha}{\partial r} \right) \) represents the change in \( \alpha \) with change in position\(^3\).

---

2 A first-order approximation will always assume a linear relation between two quantities. If this approximation holds for the description of an observation, it is called a “linear effect”. Hence, non-linear optics simply comprises effects in which the electric field is strong enough to observe deviations from a linear relation.

3 This first term of a Taylor expansion is another linear approximation.
Considering molecular vibrations, it is feasible to write $\Delta r$ as a sinusoidal function of the vibrational (angular) frequency $\omega_{\text{vib}}$ and the time $t$,

$$\Delta r = r_{\text{max}} \cos\{\omega_{\text{vib}} t\},$$

(3)

where $r_{\text{max}}$ is the vibrational amplitude.

Incident light of frequency $\omega_{\text{in}}$ is an electromagnetic wave whose electric part can be written in sinusoidal form, too, as

$$E = E_{\text{max}} \cos\{\omega_{\text{in}} t\}$$

(4)

with field amplitude $E_{\text{max}}$.

Substitution of equations (2) to (4) into (1) results in the expression

$$\mu = \alpha_0 E_{\text{max}} \cos\{\omega_{\text{in}} t\} + \left(\frac{\partial \alpha}{\partial r}\right) r_{\text{max}} \cos\{\omega_{\text{vib}} t\} E_{\text{max}} \cos\{\omega_{\text{in}} t\}.\quad (5)$$

Now, the second product of two cosines in the second term of equation (5) can be rewritten with the help of

$$\cos a \times \cos b = \frac{1}{2}[\cos(a + b) + \cos(a - b)]$$

(6)

to give

$$\mu = \alpha_0 E_{\text{max}} \cos\{\omega_{\text{in}} t\} + \frac{r_{\text{max}} E_{\text{max}}}{2} \left(\frac{\partial \alpha}{\partial r}\right) [\cos\{(\omega_{\text{in}} + \omega_{\text{vib}}) t\} + \cos\{(\omega_{\text{in}} - \omega_{\text{vib}}) t\}].\quad (7)$$

Equation (7) demonstrates that when a light wave interacts with a vibrating (diatomic) molecule, the induced dipole moment describes an oscillation with three components. And an oscillating electrical dipole (moment) emits electromagnetic radiation by itself.

The first term contains the variable $\omega_{\text{in}}$, which is the frequency of the incoming light. This term describes the emitted photon that has the same frequency $\omega_{\text{in}}$, i.e., this term ultimately explains the phenomenon of Rayleigh scattering.

The other terms comprise the factor $\left(\frac{\partial \alpha}{\partial r}\right)$. If this change of polarizability upon change of geometry is zero, they disappear. In addition, one term comprises the term $\omega_{\text{in}} + \omega_{\text{vib}}$ in its cosine, describing an emitted photon whose frequency is increased by $\omega_{\text{vib}}$ compared to the incident photon. In turn, the other cosine term contains $\omega_{\text{in}} - \omega_{\text{vib}}$, which relates to an emitted photon of frequency that is decreased by the same amount, $\omega_{\text{vib}}$.

These two terms ultimately explain Raman scattering. They show that incident light waves can result in the emission of electromagnetic waves shifted in frequency, up and down, by amounts equal to vibrational frequencies of the molecule (dipole) involved. The amplitude of the emitted wave changes in phase with the molecular vibration: The molecule emits an amplitude-modulated electromagnetic wave.

In other words, equation (7) shows that by analyzing the light scattered by a molecule, the vibrations within a molecule can be monitored. This is the basis of Raman spectroscopy.

From the derivative $\left(\frac{\partial \alpha}{\partial r}\right)$, we obtain a gross selection rule: A molecular vibration will be Raman active only if the vibration causes a change in polarizability.

II.2 A Quantum Mechanical Picture

The quantum mechanical approach to the description of light scattering is quite different. It depicts scattering as a two-photon process. Both Rayleigh and Raman scattering involve two almost simultaneous transitions proceeding via so-called virtual states.

The term “virtual state” refers to a transition state (or level) which does not correspond to a quantized energy state of the molecule; so it is only an imaginary state, a practical convenience by which the energy exchange between the radiation field and the molecule during the scattering process can be split up into two one-photon transitions.
The first step is the combination of a photon and a molecule to raise the molecule to a higher energy level.

This transition is depicted in Figure II.1 by the up arrows $\hbar \omega_{in}$. In the case of scattering, the higher energy level (dashed lines) does not correspond to an eigenstate of the molecule. The second step, indicated by the down arrows, involves the release of a photon after a time interval of about $10^{-11}$ s. The energy of this second photon is given by the arrow lengths. Therefore, for Rayleigh scattering (b) the “up” and “down” transitions have the same energy as, in the Rayleigh process, no change in frequency of the photon occurs.

Concerning the Raman processes two things are clearly distinguishable. If the “down” arrow ends at a vibrational energy level that is higher than the starting level, a Stokes process has occurred (c). In this, the second photon has the frequency $\omega_{in} - \omega_{vib}$ corresponding to the third term in (7). Conversely, an anti-Stokes process (d) results from the transition terminating at a vibrational energy level lower than the starting level. Then the second photon has a frequency $\omega_{in} + \omega_{vib}$, giving the same result as the second term in (7).

For both Stokes and anti-Stokes processes, a selection rule can be derived (not shown here) which says that the vibrational energy level can only change by $\Delta v = \pm 1$. Thus, (7) derived from the classic model agrees with the results obtained by considering quantized levels in that both models predict that the difference in frequency between the incident and scattered light corresponds directly to the molecular vibrational frequency $\omega_{vib}$.

In summary, Raman spectroscopy is a technique that uses Raman-scattered light resulting from inelastic photon-molecule interactions to investigate molecular properties. “Inelastic” means that there is an exchange of energy with a consequent change in photon frequency, and hence wavelength of the photon. Since total energy is conserved during the scattering process, the energy “gained” or “lost” by the photon must correspond to an energy change within the molecule. By measuring the energy shift of the scattered photon, changes in molecular energy can be probed. These changes are related to transitions between specific molecular energy levels. Therefore, by
monitoring the inelastically scattered photons one can probe molecular vibrations\(^4\), and the Raman spectrum is a vibrational spectrum.

For completeness, Figure II.1 also includes the process of infrared absorption, shown as process (a). This illustrates that the information obtained by infrared absorption spectroscopy and Raman spectroscopy refers to similar transitions.

### II.3 The Appearance of a Raman Spectrum, Quantities & Units

The typical appearance of a vibrational Raman spectrum is illustrated by the spectrum of water shown in Figure II.2.

![Raman spectrum of water](image)

**Figure II.2: Raman spectrum of water, showing different abscissae. Incident wavelength 488 nm.**

Historically, spectroscopists have tended to specify the wavelength rather than the frequency or the energy of the radiation, because this is the quantity most easily determined directly in the region of vibrational spectroscopy, by using diffraction gratings of known ruling spacing. This range is about \((1 \ldots 1000) \, \mu m\).

Today, vibrational spectra are almost universally given in reciprocal wavelength or wavenumber units, usually inverse centimeters. This is because in theoretical treatments or in quantum-mechanical calculations energy levels are calculated, and the differences between energy levels are proportional to the wavenumber \(\tilde{\nu}\) of the corresponding radiation,

\[
E = h\omega = hv = \frac{hc}{\lambda} = h\tilde{\nu}. \tag{8}
\]

Therefore, in terms of wavenumbers the range of the fundamental vibrations is roughly \((10 \ldots 4000) \, cm^{-1}\).

\(^4\) The contributions originating from molecular rotation and translation are omitted here.
The quantities and units in Figure II.2 are now clear. Instead of quoting $\lambda$ at which the radiation was detected, the equivalent quantity $\tilde{\nu}$ is used for the bottom abscissa. Now the excitation occurs at $\tilde{\nu} = \frac{1}{\lambda} = 20492 \text{ cm}^{-1}$.

The second abscissa at the bottom represents the "Raman shift", i.e. the wavenumber difference between the scattered and incoming photons. This is the usual convention in Raman spectroscopy: The relevant information are the positions of the vibrational peaks relative to the excitation light. These differences span exactly the same range as in infrared absorption spectra. Thus, the Raman shift scale seen in the water spectrum above is usually the only scale encountered in published Raman spectra.

Finally, there is a third abscissa at the top of the Figure, giving the (absolute) wavelength at which the signal was detected. Keeping in mind the relation of equation (8), it is clear that this scale is not linear compared to the wavenumber axes at the bottom. This also needs to be kept in mind when "converting" spectra between these quantities: A spectrum collected using a grating monochromator with fixed slit width will use the same wavelength interval for each measured data point, i.e. the intensity is measured as $i(\lambda)d\lambda = f(\lambda)$ with constant $d\lambda$. Plotting data at a wavenumber axis, the usual convention is to have data in the form of $i(\tilde{\nu})d\tilde{\nu} = f(\tilde{\nu})$ with a constant $d\tilde{\nu}$. Thus, it is not sufficient to just replace $\lambda$ by $\tilde{\nu}$, but also the interval $d\lambda$ needs to be "converted".

II.4 STOKES VS. ANTI-STOKES – THERMAL EFFECTS

When measuring Raman spectra, one finds that the Stokes Raman feature is always more intense than the anti-Stokes equivalent.

Remember, in the classic model, (7) indicates no difference in the expected intensities of pairs of transitions, since the coefficients of the two terms in (7) are the same. To understand the intensity differences one must consider the energy levels involved in the process i.e. the quantum mechanical picture. For anti-Stokes transitions to take place the molecule must be able to return to a lower vibrational level than the one it started from. To do this, it must be in a higher vibrational state ($\nu > 0$) within the electronic ground state before the scattering event. The temperature dependent population of these higher states is governed by a Boltzmann distribution,

$$N(\nu = n) = \exp \left\{ -\frac{n\hbar\omega_{\nu}}{k_B T} \right\}$$

with the absolute temperature $T$, and the Boltzmann constant $k_B$. As a result, the population of excited vibrational states is always less than that of the ground state. For a molecule in a higher vibrational state, Rayleigh, Stokes and anti-Stokes scattering can occur. But for each transition, not only must the starting state be populated, but also the final state must be empty. So even starting from higher vibrational states, anti-Stokes scattering will be less likely than Stokes scattering. For the intensity ratio of anti-Stokes to Stokes lines $I_{as}/I_s$, the equation

$$\frac{I_{as}}{I_s} = \frac{(\tilde{\nu}_0 + \tilde{\nu}_i)^4}{(\tilde{\nu}_0 - \tilde{\nu}_i)^4} \exp \left\{ -\frac{\hbar \tilde{\nu}_i}{k_B T} \right\}$$

has been derived previously including a factor that accounts for the effect that the actual wavenumber $\tilde{\nu}_i$ of the scattered photons has on the intensity.
II.5 **Raman Spectroscopy versus Infrared Spectroscopy**

Measuring the infrared, and then the Raman spectrum of a compound, the results can be very different. This seems a little strange since both are measuring the same thing – the vibrational behavior of the sample.

<table>
<thead>
<tr>
<th>$\tilde{v}$ (cm$^{-1}$)</th>
<th>Mode Description</th>
<th>Spectrum Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>3374</td>
<td>C-H symmetric stretching</td>
<td>Raman</td>
</tr>
<tr>
<td>3282</td>
<td>C-H asymmetric stretching</td>
<td>IR</td>
</tr>
<tr>
<td>1974</td>
<td>C-C stretching</td>
<td>Raman</td>
</tr>
<tr>
<td>730</td>
<td>H-C-C-H wagging</td>
<td>IR</td>
</tr>
<tr>
<td>619</td>
<td>H-C-C-H bending</td>
<td>Raman</td>
</tr>
</tbody>
</table>

*Figure II.3: Vibrational modes of ethyne.*

Figure II.3 shows the normal vibrations of the linear molecule ethyne$^5$ (H – C ≡ C – H). To see which vibrations are visible in the IR spectrum (i.e. IR active vibrations) is relatively straightforward. These are those vibrations during which there is a change of dipole moment $\mu$. Ethyne has no permanent dipole moment but, when it vibrates in the $\tilde{v}_2$ mode, the asymmetric C-H stretching vibration, a dipole moment results from the unequal C-H bonds. Similarly, a dipole moment is produced during the *cis* bending (wagging) vibration, $\tilde{v}_4$. Therefore, both $\tilde{v}_2$ and $\tilde{v}_4$ are infrared active, as indicated on the right-hand side of the figure.

To determine whether a vibration is Raman active is not as simple. The polarizability $\alpha$ of a molecule in various directions is conventionally represented by drawing a polarizability ellipsoid. In general such an ellipsoid is defined as a three-dimensional surface whose distance from the electrical center of the molecule is proportional to $\frac{1}{\sqrt{\alpha_i}}$, where $\alpha_i$ is the polarizability along the line joining a point $i$ on the ellipsoid with the electrical center. When the molecule vibrates in the $\tilde{v}_1$ mode, the symmetric C-H stretching vibration, you can imagine the polarizability ellipsoid breathing in and out: the polarizability is changing, and the vibration is Raman active. Similarly, $\tilde{v}_3$, the C-C stretching vibration, is Raman active. Although this is not so easy to see, $\tilde{v}_2$ is not Raman active because the ellipsoid of the stretching of one C-H bond is cancelled by the contraction of the other one. During the *trans* bending vibration $\tilde{v}_5$, the polarizability ellipsoid is distorted, and the vibration is Raman active. The distortions produced by the motions of the carbon and hydrogen atoms during the *cis* bending vibration $\tilde{v}_4$ cancel, and the vibration is not Raman active.

In addition, ethyne provides a good example of the mutual exclusion rule. It states that the infrared and Raman activity of vibrational modes in any molecule which has a center of symmetry are mutually exclusive. Vibrations which are active in the IR spectrum are not active in the Raman spectrum and vice versa. This can be explained by group theory.

In summary, some vibrations give rise to a change in dipole moment $\mu$ as they contort the molecule. Thus, they can resonate with electromagnetic radiation of the same frequency and give rise to infrared absorption (or emission). In this case, $\left(\frac{d\mu}{dr}\right)_0 \neq 0$. Some (other) vibrations give rise to a change in polarizability $\alpha$ as the molecule vibrates and these give rise to Raman scatter.

$^5$ also known as acetylene
Here, $\left( \frac{d\alpha}{dr} \right)_0 \neq 0$. In addition, in centro-symmetric molecules vibrational modes give rise to either infrared or Raman features but not both. Also strong infrared absorptions appear usually as weak Raman features and vice versa. Figure II.4 shows the infrared and Raman spectra of polybutadiene as an example. Hence, infrared and Raman spectroscopy provide complementary images of molecular vibrations. So, we have two methods of looking at molecular vibrations. Since they originate from different processes, there really is no reason why the spectra should look similar.

Figure II.4: Infrared and Raman spectra of polybutadiene\(^7\).

### II.6 **Polarization Properties of Raman Scattering**

The relevance of polarized light to Raman spectroscopy is that some lines in Raman spectra are found to be (linearly) polarized to different extents even though the exciting radiation is completely depolarized. On the other hand, if the (laser) excitation is linearly polarized, a change in polarization by the scattering process can be observed.

The relative intensities and polarization properties of the Raman lines depend on the scattering geometry being defined by the relative orientation of the directions of illumination and observation.

In practice (for macrosampling), the 90° scattering geometry has become widely used (cf. Figure II.5).

By convention, the intensity of depolarized scattering (i.e. the scattering of altered polarization) is measured relative to the intensity of scattering with unaltered polarization, the states of
polarization being considered with respect to that of the incident light. From this follows a simple definition of the so-called depolarization ratio as

$$\phi = \frac{I_{\perp}}{I_{\parallel}},$$

(11)

where subscripts $\perp$ and $\parallel$ refer to the mutual orientation of the electric vectors of the incident radiation and the scattered light.

The determination of the state of polarization of the scattered radiation is of great importance because it can be correlated with the symmetry of scattering species and the symmetry of the individual vibrational modes.

In general, it can be stated that a completely symmetric vibration gives rise to a polarized or partially polarized Raman line while a non-symmetric vibration gives a depolarized line. A complete theoretical analysis of polarized Raman scattering is complex and involves averaging scattered intensity of tumbling molecules and all possible orientations and molecular polarizability components. According to theory, for samples consisting of an assembly of randomly orienting molecules (as in most liquids), if the degree of depolarization, $\phi$, is less than $\frac{3}{4}$, then the vibration concerned is symmetric and the Raman line is described as 'polarized', while if $\phi = \frac{3}{4}$ the line is 'depolarized' and the corresponding vibration nonsymmetric. Especially, $\phi$ should be zero for totally symmetric vibrational modes.

As an example, the low-frequency part of the two differently polarized Raman spectra of liquid chloroform, CHCl$_3$, is shown in Figure II.6. The strongest two bands at 669 cm$^{-1}$ and 368 cm$^{-1}$ are almost completely polarized, so they must belong to the totally symmetric stretching ($\nu_3$CCl$_3$) and symmetric deformation ($\nu_5$CCl$_3$) vibrations, respectively, whereas the two depolarized bands (with $\phi \approx 0.75$) belong to the antisymmetric $\nu_{as}$CCl$_3$ (at 761 cm$^{-1}$) and $^1$CH (at 263 cm$^{-1}$) vibrations.
II.7 The Concept of Group Frequencies

A complex molecule can be considered as a system of coupled inharmonic oscillators. Empirically it is found that vibrational coupling is restricted to certain sub-molecular groups of atoms. This coupling is relatively constant from molecule to molecule, so that the sub-molecular groups produce bands in a characteristic frequency region of the vibrational spectrum. These bands – the characteristic group frequencies – (see the next table below) are "predictable" and so form the empirical basis for the interpretation of vibrational spectra. For example, the vibrational spectra of n-heptane, n-octane, and n-nonane have a number of bands in common; these are the group frequencies for normal alkanes.

<table>
<thead>
<tr>
<th>Group</th>
<th>Wavenumber/cm⁻¹</th>
<th>Group</th>
<th>Wavenumber/cm⁻¹</th>
</tr>
</thead>
<tbody>
<tr>
<td>C–H stretch</td>
<td>2960</td>
<td>C–F stretch</td>
<td>1100</td>
</tr>
<tr>
<td>=C=C=H stretch</td>
<td>3020</td>
<td>O–H stretch</td>
<td>3600</td>
</tr>
<tr>
<td>=C–H stretch</td>
<td>3300</td>
<td>N–H stretch</td>
<td>3350</td>
</tr>
<tr>
<td>C=C stretch</td>
<td>1650</td>
<td>C–H bend</td>
<td>1100</td>
</tr>
<tr>
<td>C≡C stretch</td>
<td>2050</td>
<td>C–H bend</td>
<td>700</td>
</tr>
<tr>
<td>C≡O stretch</td>
<td>1700</td>
<td>C≡H bend</td>
<td>1450</td>
</tr>
<tr>
<td>C≡N stretch</td>
<td>2100</td>
<td>C≡C–C bend</td>
<td>300</td>
</tr>
</tbody>
</table>

*Figure II.7: Characteristic group frequencies of hydrocarbons.*
II.8  Raman Spectroscopy of Polymers & Microsampling

An $N$-atomic molecule possesses $3N$ degrees of freedom. Subtraction of the pure translation and rotations of the whole molecule leaves $(3N - 6)$ vibrational degrees of freedom ($3N - 5$ for linear molecules). Thus, an water molecule vibrate in 3 different modes, an ethane molecule vibrate in 18 modes. Now, for example, consider the polyethylene molecule (molecular weight of approximately $50000 \frac{g}{mol}$), containing on average $4000$ CH$_2$ units per chain. We would therefore expect some $36000$ normal modes of vibration. The Raman or infrared spectrum of a polymer might thus be expected to be impossibly complicated.

Fortunately, vibrational spectra of polymers never show such a large number of corresponding bands. The basic reason is that the macromolecule consists of a large number of chemically identical units, each of which usually contains only tens of atoms or fewer. This leads to a considerable reduction in the complexity of the spectrum. One can show that the spectrum of a polymer is to a first approximation that of its repeat unit.

It follows immediately that the spectrum is an aid to find out what kind of repeat units are present in a sample of an unknown polymer or polymer blend. If residual monomers or additives
are present or if the polymer contains degradation products, these will usually have their own characteristic spectra which can be distinguished. In addition to providing information about the chemical structure, one can also obtain very useful information about the physical structure. Any two regions of the polymer which differ in the way the repeat units are arranged may show detectable differences in their spectra.

Viewing an polymer as being constructed of repeat units linked by chemical bonds, the spectral bands may then be assigned largely on the basis of the characteristic stretching and deformation vibrations of the specific groups that comprise the polymer. By using so-called functional group correlation tables it is possible, for example, to ascertain whether the spectrum is that of an aliphatic or aromatic hydrocarbon polymer, a polyester, a polyamide, etc.

Raman spectroscopy is particularly suited to the study of organic polymeric materials because of the sensitivity of the technique to the structure of molecules containing non-polar species such as (C–C) and (C=) bonds. Once again, also polymers follow the normal trends that strong bands in the Raman are weak in the IR, while intense bands in the IR spectrum are weak in the Raman.

More subtle information can be obtained. For example, the spectral bands of an amorphous polymer are usually broader than those observed for the polymer in a crystalline or semicrystalline state, since, for a specific vibration many more differently phased vibrations occur for the amorphous material than with the more regular structures (see Figure II.9).

Finally, many polymers are supplied as products in which the polymer chains are oriented (aligned) to some controlled extent (e.g. fibers, films); this imparts certain desirable end-use physical properties, such as directional stiffness. Using polarized radiation, information can be
obtained about the degree of molecular orientation, which in this way leads to a better understanding of the properties of the materials.

II.9 BASIC EXPERIMENTAL ASPECTS

In the earliest days of Raman spectroscopy the instruments used consisted of the components presented schematically in the following figure (at the left). The picture (at the right) shows "Raman's Spectrograph" from 1928.

![Raman's setup](image)

Figure II.10: Raman's setup.

Nowadays the basic requirement for studying Raman scattering are

1. a monochromatic light source, usually a laser (operating in the visible region)
2. an appropriate sample chamber
3. a dispersive element, usually a double or triple monochromator to disperse the the scattered light and reduce stray light
4. a suitable photodetector (PMT or CCD).

II.10 THE ACTUAL EXPERIMENTAL SETUP

II.10.1 Instrumentation – Conventional Raman

A number of stages are involved in the acquisition of a Raman spectrum using a conventional approach. A sample is mounted in the sample chamber and laser light is focused on it with the help of a lens. The scattered light is collected and focused onto the entrance slit of the monochromator.

The vast majority of the light scattered from the sample is elastically scattered and carries very little useful information. This Rayleigh scattered light must be blocked by the spectrometer before the Raman scattered light can be analyzed successfully. In the setup, the Rayleigh contribution is blocked with the help of a notch filter.

The monochromator effectively rejects Rayleigh scattered and other stray light and serves as a dispersing element for the incoming radiation (sometimes more than one monochromator is used to obtain high resolution and/or better suppression of the Rayleigh line).

The light leaving the exit slit of the monochromator is collected and focused on the surface of a detector. Using a photomultiplier tube (PMT) detector, the light intensity at various frequencies is measured by scanning the monochromator.
In contrast, when a multichannel detector (CCD) is used, a spectral range is simultaneously recorded. The CCD-detector consists of many photosensitive elements (pixels) placed next to each other. As the light is dispersed by the grating, different wavelengths are detected simultaneously by different pixels. Thus the CCD will reduce the integration time, typically less than 30 s. The instrument works as a spectrograph.

II.10.2 Scattering Geometries

There are two geometries in which a sample is studied in Raman spectroscopy, depicted in Figure II.11.

In the 90 degree geometry, the exciting laser beam and the axis of the collection lens are at 90 degrees to each other (Figure a). In the 180 degree scattering geometry (also called back scattering mode) these two axes are coincident (Figure b).

The 90 degree scattering geometry is frequently used in the conventional approach. However, when a microprobe is used to study small regions of a sample the geometry is invariable set at 180 degrees.

II.10.3 Macro- and Micro-Sampling

Previously, samples in Raman spectroscopy were almost always studied at the macro level. When a sample is analyzed using the macrosampling mode, the obtained spectrum provides average information over a large sample area. This is so even in cases where a sample is heterogeneous at the micro level.

The problems associated with Raman spectroscopy include the small Raman cross-section which mainly results in very low signal levels. The intensity $S$ of the signal collected by the detector of a spectrometer analyzing a given Raman line at the wavelength $\lambda$ can be expressed by

$$S = I_0 \sigma_\lambda N \Omega T_\lambda s_\lambda,$$

(12)

with $I_0$ the laser irradiance at the sample ($\frac{W}{cm^2}$), $\sigma_\lambda$ as differential cross-section for the Raman line analyzed ($\frac{cm^2}{sterad\times molecule}$), $N$ the number of molecules in the probed volume, $\Omega$ the (solid) angle of collection of the Raman light, $T_\lambda$ the throughput of the instrument at $\lambda$ and $s_\lambda$ the sensitivity of the detector at $\lambda$.

When a very small volume (or area) of matter has to be examined, only a few parameters can be modified to compensate for the large reduction in $N$ (the number of molecules), namely $I_0$ and $\Omega$. The best approach is the use of microscope objectives for both illuminating the sample and collecting the Raman signal. The objective focusses the laser beam into a very small volume (considerable increase of $I_0$) and collects under a wide angle $\Omega$. With the development of a Raman microprobe, samples in the $\mu$m region can now be examined.
III. EXPERIMENT EXECUTION AND ANALYSIS

III.1 GENERAL REMARKS

In preparation of the experiment, familiarize yourselves with processes that may occur when light interacts with matter, such as scattering, absorption and luminescence. How can these processes be explained and identified?

From a technical point of view, familiarize yourselves on how “white” light can be separated into its different wavelengths, i.e. how a (grating) monochromator works. What needs to be considered if data that was collected using a monochromator measuring at constant wavelength intervals is to be plotted as function of energy (or wavenumber)?

As you will be working with a luminescence spectrometer and a Raman spectrometer, you should be able to explain the principal setup and operation of these types of spectrometers.

III.2 LIGHT SCATTERING & FLUORESCENCE — AN INTRODUCTORY EXPERIMENT

Because the experimental setup for the observation of both phenomena is the same, fluorescence and light scattering are often observed in a single experiment.

1. Using a commercial luminescence spectrometer, the emission spectra of an aqueous solution containing a very weakly fluorescent species has to be monitored. This will help you to become familiar with the spectrometer and to choose the appropriate scanning parameters.

2. Identify the origin of all the spectral features found, whether it is fluorescence or light scattering. In order to do this, change the instrument settings and perform repeated scans. Be aware that you are working with a spectrometer calibrated in wavelength units.

3. Repeat the measurement(s), now with the pure solvent.

4. Measure the fluorescence spectrum of a polymer in solution. In contrast to atomic emission spectra, luminescence spectra of molecules and polymers show a substructure in addition to purely electronic transitions. Familiarize yourselves with the origin of this substructure as it will be required for the analysis of your data.

III.3 THE RAMAN SPECTROMETER — WAVENUMBER CALIBRATION

5. Using a sample of solid polystyrene, get to know the special configuration of the Raman spectrometer used for the lab course. Optimize the signal. There is a short instruction manual in the appendix and available at the setup.

6. Once you know the basic operation of the spectrometer, you need to calibrate its wavenumber axis. This is crucial for all following tasks.

7. Propose and discuss suitable methods to check the wavenumber accuracy of your spectrometer. Check the wavenumber accuracy (after calibration).

---

6 Both fluorescence and light scattering involve the irradiation of a sample with light and the detection of the light emitted by the sample. Fluorescence is often seen as an annoying interference in Raman spectra, whereas in fluorescence spectroscopy, (Raman) scattering may be mistaken for fluorescence by inexperienced researchers.
III.4 **MEASUREMENT OF RAMAN SPECTRA**

8. Regarding the satellite peaks in the spectra from task 1, verify your preliminary assumptions by scanning the solvent sample with your Raman spectrometer. *Compare it with spectral data from the literature. Compare the number of measured peaks with the number of normal modes expected. Describe the type of molecular motion and symmetry. Assign vibrational modes to each peak and discuss the Raman activity of the normal modes. Use the information gathered here for a quantitative analysis in the report.*

The entire spectrum of a chemical compound is its fingerprint. Each peak in that spectrum, however, is characteristic of a piece of that chemical’s structure. The objective of this section is to recognize characteristic peaks of organic functional groups in Raman spectra.

9. For the polymer solution of task 4, measure its Raman spectrum and a Raman spectrum of the pure solvent. *Identify peaks originating from the polymer and use them to explain features you found in the luminescence spectrum. Again, be quantitative, i.e. state the energies of the states involved. It may be helpful to draw an energy diagram depicting the involved transitions. Here, it is not so much important to scale the energy axis properly but to name the energy levels and transitions.*

10. Obtain vials containing unknown organic solvents and measure their Raman spectra. *Identify the unknown organic compound with the help of a chart of characteristic group frequencies and / or a spectra library. Comment on the reasoning for the identification of the samples.*

11. Identify a common plastic sample by measuring its Raman spectrum. *You may bring a sample of your own. Discuss the problems which appeared and name the limiting factors.*
IV. INSTRUMENTATION

IV.1 PERKIN-ELMER LS 55 LUMINESCENCE SPECTROMETER

- Program icon: FL WinLab
- Main Window (Figure IV.1)
  - opens a status window
  - double click on a method from the list to open its “Application” window
- Status window (Figure IV.1)
  - Double click on Ex. Mono or Em. Mono to change Emission filter. Different OD and cut-off filters are installed. Slit and wavelength settings will be ignored when a scan is performed (to be set there).
  - Double click on Ex. polarizer or Em. polarizer to change its setting.

Figure IV.1: FL WinLab main and status windows.

- Scan / Setup parameters
  - Select the type of spectrum you want to measure

Figure IV.2: FL Scan setup and results windows.
• **Excitation** = fixed detection wavelength, excitation wavelength range
• **Emission** = fixed excitation wavelength, wavelength range for detection
• set scan parameters: **Start** and **End** of range, fixed **Excitation** or **Emission** wavelength, **Ex Slit** width, **Em Slit** width (in terms of spectral resolution, 2.5 to 11 nm). **Scan Speed** determines instrument accuracy.

  o **Result Filename**: All files are stored as text files in a default location using that name. Check **Auto increment filenames** to avoid overwriting existing data.

  **Attention**: The resultant filename must not exceed 8 letters (including the auto increment, which uses 3 letters) to avoid potential data loss.

• **Start Measurement**: “Traffic light” button

• **Scan / View Results**
  o All spectra that have not been overwritten will be shown here.
  o rescale x axis, y axis, both axes
  o show a data cursor
  o at the bottom, a legend with all visible plots is shown (scrollable)
  o when data cursor is activated, x and y values for the cursor position are given in the legend

• Copy your data files to your own folder on drive T:

### IV.2 Raman Spectrometer “Advantage 200A” and “NUSPEC Basic” Software

#### IV.2.1 Getting started

At the back of the Raman Spectrometer (in the top right corner) you will find the ON/OFF switch. On the front of the spectrometer there are two small LEDs. On the left, a laser cooling light (blue), and on the right a laser ON light (amber).

**LASER RADIATION WARNING!** When acquiring data the system will emit up to 3 mW at 633 nm through its output optics. Only authorized personnel should change or install optical components or attachments.

The Advantage 200A is specifically designed for ease of use. Spectra of liquids or solids in standard sample vials are obtained by simply placing the sample in an appropriate distance from the sampling optics. The focal length of the “Right Angle Input Optics” is approximately 16 mm. With the system displaying real-time spectra (see below), properly focus the laser beam onto the sample material by optimizing the sample distance. For liquids, the focus is not critical, and there is a large range over which the adjustment causes very little change in the spectrum. When the sample is too far away from the instrument, there is a decrease in signal and perhaps an increase in background as the glass sample vial itself moves into focus. Similarly, if the sample is too close, the sample vial will dominate the spectrum. Once the laser is focused for optimal signal, the user should not need to make further adjustments when changing samples. However, the distance is dependent on the index of refraction of the sample and may differ slightly with different samples. The ideal distance will be that at which the laser is focused just on the sample material, and not the glass vial.
IV.2.2 Software Overview

- **Program icon**: NuSpec Basic
- Laser safety dialog to be acknowledged by the correct password
- Connect to the spectrometer via Devices → Connect a Device → COM3
- **Advanced Options / Reference Mode**: select Software for an automated background correction
- **Acquire Options / Integration Time**: full seconds from 1 s to 99 s
  - In case of a weak Raman signal, the simplest way to improve spectra is to increase the integration time. The noise level will decrease by $\frac{1}{\sqrt{\text{integration time}}}$ while the signal increases linearly with the integration time. With clean samples, this is the best way to improve spectra.
  - The maximum “intensity” is approx. 40000 counts. Keep the highest feature close to, but not above this value.
  - In “software” reference mode, a background spectrum will be taken automatically with the same integration time and blocked laser.
  - “Auto integration” supposedly selects an “ideal” integration time
- **Acquire** button: takes a single spectrum with the selected settings
- **Continuous** button: take repeated spectra with the selected settings (including one baseline at start if selected)
- **Abort** button: aborts running measurement
- **Laser Power** can not be changed
- Signal improvement by averaging over several spectra: enter the number of acquisitions to be averaged into the field **Advanced Options / # of Spectra**. The resulting acquisition will take a period of $n \times \text{integration time}$, where $n$ is the number of averages selected. Spectra will be collected separately and show up as a group in the bottom list of **Loaded Spectra**. There, you can select the spectra and create an average spectrum. The more spectra are averaged, the better the signal to noise ratio.
• **Baseline** check box: When activated, an automatic baseline correction will be performed. While this may be helpful in most cases, it also may introduce some artifacts into the spectrum. However, the correction is applied reversibly for the acquired spectra and can be switched even after measurements, so you can easily decide whether it will improve your spectra or not. Make sure to check **Save Spectra with Processing** if you want to save the measurement data including background correction.

• **Level of Smoothing**: Three settings to remove noise from the data, albeit smoothing may also remove essential features. This feature is reversible as well. Make sure to check **Save Spectra with Processing** if you want to save the measurement data including smoothing.

• spectrum display scaling/zooming
  - draw a rectangle (left mouse button) to zoom into selected region
  - mouse scroll wheel zooms in
  - right mouse button + drag moves spectrum
  - CTRL + left mouse button zooms out

• The measurement range covers wavenumbers from 200 cm\(^{-1}\) to 3400 cm\(^{-1}\). This covers most Raman features. At the low end of the spectrum the intensity is attenuated due to filtering within the system.

• **Loaded Spectra**: Double click on a spectrum name (default "Entry_1") to change it. This name will be included in the header of saved data files, together with other information on the measurement conditions.

• To save a spectrum, right-click on its entry in the bottom list and select **Save Spectrum** or select **File → Save Spectrum...** from the main menu. The suggested file name will be taken from how you named the spectrum and can be changed. The best file type is "**PRN**" as this will result in a text file readable by any text editor or spreadsheet program. Store data directly to your folder at the lab course server.

• Using Origin 2018, you may need to convert the file encoding from "ANSI" to "UTF-8" to be able to successfully import the files using an external text editor. A bug report was filed.

**IV.2.3 Wavenumber Calibration**

![Figure IV.4: Screenshot of the NuSpec Basic calibration window. The four line cursors (yellow, red, green, light blue) correspond to the "Pixel Number" value of the similarly colored fields below.](image)
By default, the wavenumber axis of the spectrometer is incorrect and needs to be calibrated. The software has a built-in option to do this. Using **Options → Specify Calibration Peaks**, one can assign detector pixels to wavenumbers. It is suggested to use solid polystyrene to do this. When the menu option is selected, a Raman spectrum is taken with the settings selected in the measurement options (see before). The “calibration” window is shown in Figure IV.4 for reference. You can decide how many peaks should be used for calibration (**Number of Peaks**), choose at least 4. The **Window Half Width** option selects the sensitivity of the fitting routine, set it to 20 or less. In the **Wavenumber** fields, enter the values of the lines you want to use. Then, move the cursor of the same color as the wavenumber field to the peak that you want to be assigned to this wavenumber (left click on the cross of the cursor and drag it). Make sure that your peak selection covers as much of the available measurement range as possible, from 200 cm\(^{-1}\) to 3400 cm\(^{-1}\). To do so, you may need to zoom out of the plot. A reference spectrum is shown in Figure IV.5. Once you have assigned all peaks to pixels, click **Save Peaks**. The software returns to the measurement mode. Now, select **Options → Calibrate** to do the actual calibration measurement. It may be sensible to increase the **Integration Time** for noise reduction and/or more clear line assignment by the fitting routine at this point. The software will either give you the new rms accuracy (should be below 1 wavenumber)\(^7\) or show an error message. You can redo the calibration if you are not satisfied. Especially if calibration failed it may be feasible to change measurement settings and/or to recheck that the peak assignment was correct.

<table>
<thead>
<tr>
<th>(\tilde{\nu} [\text{cm}^{-1}])</th>
<th>relative intensity</th>
<th>Peak Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>620.9</td>
<td>16</td>
<td>aromatic ring pucker</td>
</tr>
<tr>
<td>795.8</td>
<td>10</td>
<td>aromatic ring quad and semicircle stretch</td>
</tr>
<tr>
<td>1001.4</td>
<td>100</td>
<td>aromatic 2,4,6 radial in-phase stretch – “breathing mode”</td>
</tr>
<tr>
<td>1031.8</td>
<td>27</td>
<td>aliphatic (\text{CH}_2) deform.</td>
</tr>
<tr>
<td>1155.3</td>
<td>13</td>
<td>aromatic ring quad and semicircle stretch</td>
</tr>
<tr>
<td>1450.5</td>
<td>8</td>
<td>aliphatic (\text{CH}_2) stretch</td>
</tr>
<tr>
<td>1583.1</td>
<td>12</td>
<td>aromatic ring quad and semicircle stretch</td>
</tr>
<tr>
<td>1602.3</td>
<td>28</td>
<td>aromatic CH stretch</td>
</tr>
<tr>
<td>2852.4</td>
<td>9</td>
<td>aliphatic (\text{CH}_2) stretch</td>
</tr>
<tr>
<td>2904.5</td>
<td>13</td>
<td>aliphatic (\text{CH}_2) stretch</td>
</tr>
<tr>
<td>3054.3</td>
<td>32</td>
<td>aromatic CH stretch</td>
</tr>
</tbody>
</table>

**Figure IV.5: Polystyrene reference spectrum and peak assignments. Table taken from \([8]\).**

**V. REFERENCES**


\(^7\) While the software states the accuracy in “wavenumbers”, this is clearly wrong. The accuracy is given in percent.
http://www.nobelprize.org/nobel_prizes/physics/laureates/1930/


**FURTHER READING**

The following publications are available from the lab course web site [http://www.uni-potsdam.de/u/physik/jprakti/Start.html](http://www.uni-potsdam.de/u/physik/jprakti/Start.html) (link "Literatur", authorization required).